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Getting Started

This manual assumes that:

The USB Ethernet Adapter driver has been loaded.

The jet.engine GUI software has been installed.

The Network Connections Settings have been configured.

The P4 has been assembled, transports paper, and is connected to the host
computer.
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If these actions have not been taken, stop and tend to them before going any
further using the P4 Mechanica!l Operating Manual.

Check Factory Settings

The operating software contains your machine’s configuration file. When you
loaded the software on the host computer the settings from factory final test and
acceptance were loaded as well. As you run through the following sections,
checking these settings. If a setting needs to be changed, follow the proce-
dures outlined in the manual.

Starting the jet.engine GUI

—

Click on Start — the Start menu will appear

2. Place mouse pointer on All Programs — the Programs menu will appear
3. Place mouse pointer on jet.engine GUI — a smaller menu will appear
4

. Click on the jet.engine GUI icon: < Launch jet.engine.gui

To start the jet.engine GUI software faster you can create a desktop shortcut,
pin it to the Start menu, or, add it to the Quick Launch toolbar on the Taskbar.

To create a desktop shortcut: right click on the jet.engine GUI program on the
Programs menu and select copy. Then right click on an open area on your
desktop and select paste. A jet.engine GUI shortcut will be created on your
desktop.

To pin to the Start menu: right click on the jet.engine GUI program on the Pro-
grams menu and select Pin to Start menu. The jet.engine GUI program will then
appear on the upper part of the Start menu.

To add to the Quick Launch toolbar on the Taskbar: click and hold on the
jet.engine GUI program on the Programs menu and drag the selection to the

&,

Quick Launch toolbar and release. A jet.engine GUI icon 7 will appear on
the Quick Launch toolbar.



Setting up the Imager

1. Start the jet.engine.gui program.

A Find Imagers window is displayed. If the computer is attached to the printer
and the printer is running, there is a good chance that the imager will be found
(check the status column).. Close the Find Imagers window.
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3. Make selections to the various buttons and windows so that they match the
above screen.

4. If there is more than one imager listed, delete all but one by clicking on the
Engine # to be deleted and then clicking Delete Engine.

5. Check the Factory Settings sheet that was supplied with the printer. On it
you'll find the factory tested Distance from Sensor. Enter this number in the
cell provided under the Distance from Sensor heading.

6. The printer depicted above prints at 600 x 300 dpi. Print resolution may be
changed by clicking on the pull down arrows in each resolution window. Our
experience is that it is best to leave the resolution alone until more experi-
ence is gained with the printer.

7. Click on the Options menu at the top of the screen and select Imager Con-
figuration. If the Imager Configuration option is disabled you must change
the Operator Mode to Supervisor, Technician or Developer.



Imager Configuration
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10.Click on The System
Settings tab.

11.0nce again, set all
buttons and informa-
tion boxes to look like

the screen to the right.

Double check settings
on the Factory Set-
tings sheet supplied.

12.Click OK to close the
Imager Configuration
window and save the
settings.
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The software is now set up to run. Proceed to load data, design a piece and print.
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Configuration Settings

By clicking File, Load Configuration you get a list of all of the configurations available
for use. A configuration is a machine description that contains settings for I/O events,
Pen parameters, System configurations etc. It is essentially the machine identity. If
you are using special inks or have several different machines running from a single
computer, you must have the correct configuration loaded.

. Nortom img_‘;ﬁ‘!_-n F;?,; S

To change a configuration, type the name that you wish to give the new set up in the
configuration window then click on the File and Store Configuration buttons. The new
configuration will be saved and used when the software is started next.



Loading Data

1

B 8

10.

Start the Software and make sure that the introductory screen is correct. This usu-
ally entails selecting top for the paper orientation.

Click on the Print Manager tab to open an empty data screen.
Click on the Data menu and select Load Data.
Browse to and select the file that you want to print.

If the data is in a readable form, it wiill pop up in preview mode on the screen. If it
isn't, you will have to change a few things to match the GUI to the data. Let's as-
sume that the data doesn’t load immediately.

An error message will pop up. Go back to the Data menu and select Modify
Schema. You will need to know about the structure of the file you wish to load.

This is where the answers to the basic data file questions come in handy. Start on
the left and supply the answer to the Record, and Field delimiter questions. Click
OK.

If you get it right, the data file will be open in the GUI. If you get it wrong, keep try-
ing.

Now you can name the fields in the data. Go back to the Data menu, and select
Modify Schema.

Click on each field in the Field Properties box. When vou select a field, you can
Define it, Edit it or Delete it. Click on Edit and type in a name for the field. Con-
tinue untii you have given all of the fields a relevant name. (screen below has

named only one field). When finished, click OK. Your file is loaded.
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Screen as it will look when your file is loaded properly (on Print Manager tab)

Print Manager Tab

1.

There is not much that you can do from this screen. Basically, you select auto
scroll and watch the job run. As the Printer runs, numbers appear in the Speed,
Pieces/Hour and Time Remaining boxes. The counter increments and other
counts are kept. When you select auto scroll, the list advances up the screen as
it prints.

If, after starting the job, the counter doesn't increment, the piece sensor is not
detecting the piece. If there is no indication of speed, the encoder system is not
working. Report these conditions to service if nead be.

Selecting Stop on Error will stop printing when a bad record is detected. It is
usually best to not select this option. Bad records will be highlighted in RED and
can be dealt with at the end of the run. Records with errors do not print.

Use the Ink status box as an estimating and cost tracking tool. Make sure that
the ink cost has been entered correctly in system set up and that the piece de-
sign is complete before relying on the cost calculations.

Trying to print faster than the resolution will allow causes the speed indicator to
turn red and stop printing.



Layout Tools Overview

Each of the following tools creates a block, or area of printing. Each of these areas
has similar characteristics while each has a significantly different use and purpose. To
fully understand the strength and flexibility of the GUI, one must understand the use of
each of these tools. To print addresses, the operator needs to understand a record
block. Each icon on the Tool bar links to one of the following tools.
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Layout Tools Defined

Bitmap — Creates an area dedicated to a
graphic image. The most common format
is bitmap (.bmp). No text is allowed in this
box unless that text has been converted to
a bitmap format.

Message Line — Creates an area of text
that is operator defined. The operator
may type in a fixed message or enter
cues to have variable data messages
printed in the block.

Record Block — Creates an area of print

that actually duplicates fields in the data

on a line-by-line basis. Where each data
base column represents a line in the re-

cord. No rich text features are available.

Field Block — Creates an area of print that
can be user defined based on the fields in
the individual records. Some rich text fea-
tures can be applied to elements in the
field block.

Number Generator — Creates an area of
text dedicated to a number, usually se-
quential. The operator can select various
numbering criteria and apply it to each

record printed.

Indicia — Creates an area of text that is
dedicated to USPS postage payment indi-
cia. The operator may change text attrib-
utes and indicia formats, but can not insert
data from the data base.

Variable Bitmap — Creates an area that
contains a graphic that is specific to the ad-
dressee. The operator can set up graphic
selection criteria and different graphics will
be printed with different addressees.



Mail Piece Layout

Let's review. The machine is hooked up and running, the data base is loaded and the
job is open. All that remains is to tell the printer what to print where. This section will
give you the basics of mail piece design and layout. You'll be able to perform entry
level printing tasks that will satisfy a customer’s needs. After the skills outlined in this
section are mastered, we can get into some of the more intricate design features and
capability.

Blank Form Design Screen

1. Click on the Form De- ===
sign tab. An empty de-
sign screen comes up. E==I-
If it doesn’t, you may not
have selected the top of
the paper in the initial
Imager Setup screen.

2. In the left margin, from
top to bottom, are the
imagers and pens.
Check to be sure that
this agrees with the ac-
tual number of imagers .
in the machine.

3. The ruler across the center of the screen represents the width of the form se-
lected. If this isn't correct, return to the Imager Setup screen and select the
proper size for the form. In the example above, we have 4.5 inches of print
across an 8.5 inch wide (letter) sheet.

4. There is a Tool Bar across the top of the screen (font selection is in this bar).
The icons in the center section are the most commonly used form design tools.
See the Layout Tools sections for a summary of the icons and their use.

5. Click on the Record Block icon. An area of text equal to a 1.5 x 1.5 inch square
block is opened in which as many as nine lines are displayed. This block
opens under the assumption that three pens are being used to print as many as
three lines of data per pen. In the case below, the Record Block has been
dragged and dropped to a location 4 inches from the left of the paper on imager
2. When you click on a block, you make it active so that you can work on it.
Active blocks are known by the square grab handles around the perimeter of
the block and by the dark blue registration line on both margin rulers.

6. To manipulate the Record Block, either double click on it, or right click on it to
open the Properties window and select properties.
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Form Design Screen with Record Block

7. Record Block Properties w-r ®ee
are simple. Choose the a
number of lines, starting
with a particular line.
Recall that each line is
a field, or column in the
database. Identify

“whether the data is to
be printed as a text or
barcode.

8. The Rotate tab is easily
explained and rarely
used with a record block
of text. It is often used
with a record block of
bar code data. You can

“!Qg?!
15
8

rotate the block through 360°s in 90° increments, or select custom and enter the
number of degrees of rotation in single degree increments.

9. Selecting the Font tab gives you standard font style selections in which all fonts
available to the operator are shown along with a sample of the font as it will print.

Record Block Properties Screen
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Block Properties

The Block Properties tab is quite common to all blocks and needs to be explained in

detail.

Word Wrap - this is a default selection that
causes frouble in addresses. It is often
better to cut off part of a name than to have
it wrap into the next line down.

Transparent — Each block is rectangular.
This rectangu'ar block takes up space on
the piece equivalent to its dimensions, but
data is often not in the full rectangular
space. In other words there is non-printing
space assigned to the block in which an-
other biock can not print. Making the block
transparent will deiete the white space
around a block. It shows up on the screen
without this white space.

Position is Locked — Self explanatory. En-
ter the dimensions from the left edge and
top of form in the space provided, and the
record block will stay right there. The only
way to move it is to change the actual
measurements frcm the edges of the form.

Block Properties tab

{3 Upper/Lower Caselstring replacement)

{3 Word Wrap
Left: 54-9‘5‘ Top: (148 | gﬁampwm
i i Postion Is Locked
Width:{1.5 Height: (188 |
iiercdto | Resize fext when
box size chances
Generat #rad
Horizantal Vadical 0 b eadseb?:‘nrg;rs
@ Lett 3 Top Rectangls Type
{7 Center ( Center iMa Ractangle v
£ Fught ) Battam e
PonWath: (1 ¥
Casing
& None
3 ALLCAPS

Resize text when Box Size changes -
This allows you to stretch the box and
make the text larger inside it.

Generate Error If text Exceeds Borders —
This wiil either cause the machine to stop
printing if the text is too big for its box or it
will keep the record from printing. In ad-
dressing applications, it is best to leave
this one unchecked and to make boxes
long enough for the records.

Rectangle Type and Pen Width — This
puts a line around the box. The higher
the pen width, the thicker the line.

Note: The vertical line of selection
boxes must be checked prior to print-
ing to be sure that the correct settings
are made.

i ok H Cancel | | . Help |
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Using Record Blocks

The GUI is equipped with viewing tools. On the Tool bar we find an icon marked
abc. Clicking on this icon previews the data that will be printed. Using the VCR
controls lets you move through the data base from start, to end, and back. Click the
icon again to return to the default Record Biock view.

This record block represents the first record to be printed. It consists of 4 lines of
data printing in Arial 10 point font. The left edge is about three inches and the block
is approximately 5 inches long. The block is not transparent and space has been
left to allow for longer addresses and endorsement lines to be printed. The record is
printing on the second and third pens of Imager #2.

14

& 6ul -

Fle Edt
D&

i Record:

staples_barcode128.ijj *

View QOpYions Data Help
M i S T FlE=8S0a s X BEHE Al w0« B 7 UG
Jeffm [ rfwvler a0 Bl pafm|

ImagerSehp | FomDesgn | PrntMansger | [rkSiaws | 10Sitws | log |

R T T % B T ' T
Fti L ool B R [ ; . i . ; l . loe]
Seererrerserrassseeses ATOMIXED AADC 140 =
RUBEN RIVADENEIRA 148
ARIZONA SIGNS 1
________________________________________________ TAN JUAN PR 000071400 SRR
¥l - -
B B
L
For Help, press Fi Connection Status  Cleating Station Status: Unknewn  Top X: 3.85%




Printing PostNet Bar Code

There are a number of steps to go through. Start by recognizing that a record block
can not mix text and bar code data. It is one or the other. Thus, to print a bar code in
a Record Block, that block must be assigned exclusively to the bar code data field in

the record. 4
Properties Screen

1. Click on the Form Design tab,
then select the Record BIOCK | ecoock ot § Biack Propesies | Roisis | Bacode Properios]
icon. Double click on the Record || rumberstines [1 2]

Block to get the Properties | reneconioes i3]

Screen seen here. | Oislay Te
| o Ten
2. Enter 1 for the number of lines. | ®gss

Enter the line column number
from the database where the
barcode information is found. In
this case 5.

3. Select Barcode for the Display
Type. A Barcode Properties tab
will appear in the Properties win-
dow.

4. Click on the Barcode Properties | e e ey
tab.

...... =1 5. Click on the Optimize for Reso-
* e e e lution check box.

Barcode type: Nnne v i

RN - o o /| 6. Select a Shaving percent-age.
g?ﬁ:‘;m g Barcode shaving is the reduc-
Text Dietance: [0 | _ | tion in bar width to make the

: barcode more easily read. The

s | USPS Merlin system has

' ' driven this effort to allow the

[ Ot or Besd ot oot ke Hi‘“ﬂ“‘ze”:i:‘f““”‘“ supervisor to set up bar code
i o printing details on a per job ba-

Modale widh:. F ] el ey {1/1000mn) : g
gmm_ o | sis. When you print, you may
1 i 525 Tt | wish .to shave more or less de-
| Fomet/aubsel. | defeut: ompty pending on the output.
Guard width: 0 Jddak0 (/10000 7. If your data contains a barcode
% WL & oo IAIGE U/ | with check digit calculated,
| Gecoratocheckdgr: | [ETMNENN | dofaut: Standard check none. Make sure that
' Elsa e i ag your choice here is consistent
Lok J[ oot J[ e ] with the data.
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8. Select the type of barcode being

printed in the Barcode Type drop- |/ awssse: o | Beck Poporss | Retme | Sarcods Properies |

down box. | codevoe: [ ——

9. Choosing a PostNet bar code will s s ikl e
open the Postnet options box. ‘ B o i s
Again, Merlin is at work. Issues : O Vide Q1bas /ich) O 50% Shavig
of bar spacing and shaving are | Don il

revisited. If the bars are already
being shaved, select 0. To widen :
or narrow bar spacing, make the | .uews
appropriate selection.  Custom Pt ot
isn’t much of an option as the | e
range is only from 21 — 23 bars | Bmvee=

aut: emply {17 1000mm)

defaut: 0% of barcode shaved
delaut: empty

per inCh. L Guard width delat: 0 {171000mm) 1
Motch heigrt: . defaut O {1/1008mm} i
10.Click OK to return to the Form Geergegheckdgt.  Adomatc > defaut Automatic

Design layout screen.
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Printing Graphics

The Inc.Jet GUI accepts and prints bitmap graphics. When you select the Bitmap
icon, a list of .bmp files is displayed. You may use standard Windows searches to

find the appropriate bitmap file.
1. Select a bitmap and open it.

2. It appears on the Form De- osa ‘8 teuns-mas: @@ seiviwwm
sign layout screen in a s mew s

small box.

3. By grabbing the image, it
may be enlarged and
moved on the screen.
When the block is selected,
arrow keys may be used to
move the whole block in
small increments.

4. Double Click on the block to
access the Properties win-
dow. Bitmap properties are
limited to Fixed Bitmap in-
formation and rotation.

Be Et Vew Q(pbons Qota beb
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5. The controls are apparent. You &
can fix a bitmap in its location and | fedBnew Fase

lock its size to specific specifica- e o ey PR
tions.  Usually, bitmaps are e 0| T D) miﬁ;e;:m
dragged and dropped and sized by |~ BenEI BT D Sl tocked
eye during the design process. | .. e

Locking the aspect ration is useful | smwses

for logos and particularly . sized ||~ Eleckhweafao

(3 fbsolte
Widh: 566 | Height: 1178 |

graphics. Locking the aspect ra-
tion will not allow you to increase
width without changing height
automatically and accordingly.

( Scaing

7 Ressiution
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Printing Indicia

The Indicia tab is dedicated to mailing applications. The Inc.Jet GUI is set up to
automatically print a postal indicia by using this tool.

1. Click on the Indicia icon. [o———

1 ndcis | Fort Block Proparies | Rotate !

2. A dummy Indicia comes up on the
Form Design layout screen.

3. Double Click on it to get to the
standard Properties window

4. High lighted text may be edited.

5. Changes to the block may be
made as with other blocks.

6. Particular attention may be paid to
the Rectangle Type box in the
Block Properties tab.

Lox J[ Cmed J[ wo ]

7. Selecting Full Rectangle sur-
rounds the text with a printed border. Selecting various line weights makes that
border darker as the line weight increases.

8. Selecting No Rectangle eliminates the border. Check with USPS regulations to
create the appropriate Indicia.
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Number Generator

The Number Generator is a potent tool. The GUI will print consecutive numbers in
any of a variety of ways. Click on the Number Generator icon and double click the
box to open the Properties window.

1. A common application is to print consecutive numbers on each item printed. The

number will appear in the block outlined on the Form Design layout screen.

2. Select a start number with as many zeros in front of it as you will need. Here we

will count from 1 to 100.

3. Determine whether you want the number to be text or barcode. If text is selected,
a font tab is available. Selecting Barcode wiil add a barcode properties tab where

you define a barcode type and its properties.

4. The mask automatically fills in.

5. Count/Every here means count 1 for every 1 as we’re counting singly up to 100.

6. No check sums or other modifiers are selected.

ST TR
L

r Weighting [0
! Hlasx Cplions
(% # - Courter Digit (Checksummed)
i 3 - Ststic Charscler (ot Checksumimed)
{3+~ Static charscier Checksummed)
PO Chack Digt

| Humber Gererltor | Fot | Blook Propeies | Rolete |

oK | [ ”Carxe\ f! HtD ]
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Using Message Lines

The Message line tool is used to print fixed text over and over again. For an expla-
nation of the Block Properties and Rotate Tab, see Record Blocks.

1. Click On the Message Line
icon on the Tool bar.

2. A block appears on the
Form Design layout screen.

3. Double Click the block to
bring up the Properties
screen (right).

4. Replace the words “Fixed
Text” with your message.

5. This Properties screen is
the same one that is used
for other blocks. An impor-
tant item in the Message
Line is font selection.

6. Select a font from the Font
list.

7. Select a style if the font has
various styles available

8. Pick a font size.

9. Check underline or strike-
out.

20

Properties

Hlassags |ine Fm &3-:;: F'apemoe Rofde

Lisplay Type Feced Test:
) Barcode

o o ) o )

5 Fort: A
{3 of 9 Barcode
E}M FE Bold

g

R .

| | frial Black

L {Adal Namow

¢ Aal Rounded MT Bold

i Baskendlle Bold ftalc

. iBaskervile Old Face

| iBachaus 33

L Bel MT
Berkn Sans FB Bold
Berlin Sans FB Demi Bold
Bemwd MT Condansed
Binner Gothic
Biackadder {TC
Bodoni MT
Badoni MT Black

| Bodoni MT Condersed

Message Line  Fort  Block Properties  Rolate |

Font Styles: . Size:
[ Regular | fe 3
[ Bokd wafic |
e [2] tnderline
n [ Dstrkeont
|
| Sample Text _,-'nfe;;_

| Use Message Blocks for Added i
. Impact on the Piece)

[ ox ][ cance




Mail Piece Layout Review

We have the four line address with a bar code on lower right. Both are record
blocks.

ACCUFAST is a Bitmap graphic in a transparent block.

The return address is a Message Line fixed message printing on all pieces.
The indicia is an Indicia block with a full, narrow rectangle applied.

We are previewing address number 6 of 433 (field block).

The appropriate bar code is being printed in the lower right corner of the
piece as a record.

® & 0 T o

@ GUI - staples._barcode128.1jj
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Using Field Blocks

The Field Block in used when data is organized by fields, not lines. Typically,
- mail processing software has a similar step in which the user creates a “label lay-

out”. In this step, data is placed by field into a line- by — line layout. The layout is

built step by step, field by field until the finished “label” is inspected and stored.

Field blocks have an additional advantage in that a few Rich Text features (Bold,
Underline, ltalic , etc) may be applied on a per field basis.

1. Load, or check to be sure that a data

Properties

base is loaded. P B | Bk Propaes | Pruee
2. Go to the Form Design tab and click the " (!:M.“: B RS ) SR A T R R Y :

lesFitd 1
<cFold 28>

Field Block icon.

3. The Field Block will be added to your | |
design. Double click on the Field BIOCK, | famrerr o ol Doty seomstmess
or right click and select Properties to El e - L it

open the Field Block Properties window.

] Remove Blark Lines [} Ramove Lmading Whitespace from Lines
[} Remeve Traiing Whitespacs from Lines

4. The Properties window displays an Otoxo Clveta
empty layout box at the top, several se-
lection boxes in the center and the data
base to be printed in a box on the bot-
tom.

5. Click on the header for the field that you
want at the beginning of the layout.

et AOI027-11... fif

Gise | =0 1028-23, .. Hf

Mi.. | 003396 [ v

AR TONY WAL, EANBY HI...

Identify whether this is to be a text or o S e B I
barcode label and select display type.

T . i Add Fiold.

| . Move the Cursor to the point where you
want the next field to be and select it by
clicking on that field’'s header.

1

! ||8. Repeat the process until you have fin-
[IRich Text Format (RTF} AddBunclisn. v g [[] Remove Leading Witespace from Fields E iS hed
"E P,;wm‘; Suta b i oot et b bea bewbosbek b e s e (l Pcmg;'g Erﬂmg '{!ﬂrﬁtmpagg o F,egﬂ; ; - :
et e e 119. To add: a PostNet barcode to a typical
{iepiay Tyoe g i i § o % W
& Ter . mailing label, click Include in the Postnet
Fe_ | Ad;.Fl fd? | ; ;
i A 52 . o e , 10. The Edit Barcode button will become ac-
' wri i || tive when the include box is checked in

.. AMHERST M...
AMMERST M...
IE., CHICOPEE.. &
P, EASTHAMPT... 0l
L. EASTLONG,.. ~01028-23.,,
1. GRANGYHIL.. GRAMBYMA.. ~D103396.. s %] |

the Postnet box.

.
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11.This brings you to the Postnet
window. Here, make selections
relative to where the barcode is
to print. In the Field Block, the
barcode can only be printed in
the address block. You can
choose the shaving percentage,
the bar spacing, checksum
method, and the data fields to
use for barcode calculation. In
our example, the barcode data is
in field 5, so the answer to the
start and end questions is field
five. The barcode data both
starts and ends in field 5. In
some data bases, the barcode
data is spread out over several

Postnet

Location
OTop -
(¥ Bottom -
Bars Per Inch End: | EUE ¥
O Narrow (23 bars finch)
O norma! (22 bars finch) Sharving
: i
(5 wiide (21 bars /inch) Co%
Checksum (& 25%
{3 included in Data (None) O 50%
{®) Automatic Detection
O Calaulated (Postnet) O 75%

fields. When that happens, an-

swer with the beginning and end
of the barcode. Note: the bar-

code data must be in consecu-
five fields.

i Freid Bock  Block Prepedies - Rotate
BiZjUsEESH v 825 v
Pk 153 :
| cchnid 25
e<held 3>
c<Rekd 42>
(] Fich Test Forra (RTF) s Forcton | [JRemave Loaing Whtespace ron ks
[CIFrevien Cata S e E e [[IRamove Trailng Whitespacs fron Faide
Display Tyos
(@ Text FPostnet
P {
et , Wrciee e poune ]
& i Botion, 21 BP), 25%, Auemalic, Fed 510
5 i
[lasiie ] AddField]
Fedi | Fed2 | Fed3 | Feda | Reds | Fede (A
Record 1 | wewsanene . RUBENRIV.., ARIZONASL.. SAN MNP, ~G0%07-14.. fi]
Record2 | "*eesesn REZA SHAFL.. COPYCATP.., AMHERSTM.. ~g10022L.. fff
Receed 3 *%,. HORMANN... HAMILTONL.. AMHERSTHM... ~01003-23.. ff
Record 4 . CURTISED., CAOLO,BIE.. CHICOPEE... | ~01020-4L.. [/
Record § ... JOEHEBER... GAZETTEP... Ea‘:fww...#emzu.. it
Record & . KARENWIL... MOMENTUM., EASTIONG.. | ~01028-23.. fi/ i
Record 7 . TONY KWAL., GRANSYHL.. GRAMBYMA.. ~01033-96... fif vl
< a |
0k ][ Caed |[ He |

12.Click on the Preview Data check box,
and that is what you'll see. Data only,
no barcode.

13.To use the Rich Text features, click on
the Rich Text Format (RTF) check box,
select the field in the data to which you
wish to apply the feature and select the
feature. Here, we've chosen underline
and italics applied to Field 2, the ad-
dressee. When satisfied, click OK.

14.Return to the Form Design tab and se-
lect the preview mode to view exactly
what will be printing on the piece.
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Address and Barcode in one Field Block with underline
and italics applied to Name

Sort Breaks

Sort Breaks are non-printing characters that are typically inserted in the data base at
the proper place to facilitate mailing. ACCUFAST software recognizes these marks
and can send a signal out from the imager to stop the feeder. In order to be success-
ful, the sort mark should be in a separate field in the data and should not be a typically

used ch

aracter in addressing. Double number signs work well (##)

Start by:

1.

(SN

.
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With the Operating Software (GUI) open, Click Options, Imager Configura-
tion, 1/O Events.

Click NEW

In the Event name box, type sort output, in the Notes box describe what
you're doing.

Click the Enabled box

Select Data Source



Description: Motes:

2 e e AT S —— Rt > - R e , G
| Sort Output i Stops Feeder when ## is recognized { f
Qou.p Name WD 02 e S S ol (1 ol {1 pamwa) E
' 2 > i o—— [EFrS
Ele 5 | i Cefine Labels, ,, E
1 - i
e i  Tiners and Counters, ., i
) Not Defined ”
Actions

O Hardwars Input:
{%) Exeoute Actions Iramediately

) Execute Actions in the Specifiad Order

o Add pction ]

{%) Data Source

{%) Contains:

) Changes

Process when GUI receives printed notification
) System Event:

() Page Processed Count
) Timer Expired

) Countsrs

You have a choice here. Typically, if you have a short printer or are running it slowly,
an immediate stop is in order. If, on the other hand, you are using a longer bed and
the feeder is further away from the imager, there will be pieces in cue and you need to
recognize the sort break a bit sooner and stop so that the correct piece ends up last.

To stop immediately, check the “Process when GUI receives printed notification” box
under Data Source and “Execute Action immediately” under Actions.

Click:

. Add Action

1

2. Hardware output - make sure it says “Imager 1 Output 0"
3. ON

4. Immediate
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Database: fﬁ\c&muﬁsﬁvﬂ

Mot Defined Gom
il Pages tf CHardwars Inpt: Corr
4 : et

> Page Processed Court 3 Timer Action:

O Tmer Expred £ Counter Action:

(s Couners

Ink £ sttt

Preels Par Page:
14345

Pages Per ML
2323.69

Cost Per 1000 Pages

50.09

Click OK and OK again to move back to the original I/O screen. You have specified
the mark , it's general source and the action that you want to take. All that is left is to
specify the field in t he data base where the mark will occur.
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Double Click the Sort Output Evént that you just created. This opens up the select
data field box., Click on that box. Follow instructions to select a field in which the data
occurs.

This step is vital. If there is an error, the event will not be entered or useful.
To activate the Sort event click the enabled box on the I/O screen. To de-activate, re-

move the check from that box.

T T ——— ”
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) Temes E:xam_i

ety

To Begin Printing

1. Check that the printer is ready and an envelope layout is complete.
2. Click on the Start Print Job button on the Print Manager tab.

3. Notice that the speed of the belt is being continually monitored. This speed must
be within the data processing capacity of the system or the speed number will turn
red and printing will stop. Variable speed printers must be set by the operators to
run in the black. The determining factor is print resolution. Use the following speed
chart as a guideline. '

150 dpi 90 ips.
300 dpi 47 ips
600 dpi 22 ips

4. To stop printing, stop the feeder and transport belt, then click on the Stop Print but-
ton.
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There are a few decisions toc be made relative to print management. First, do you wish
to stop printing when a record with an error comes up for printing? In the example be-
low, record 15 is too short, putting important bar code information in the wrong cell. If
the data base is full of these records, stopping on each is probably ill advised. Typi-
cally, this box is left unchecked. Flawed records are skipped and accumulated at the
end of the run for examination.

Auto Abort is typically checked. This effectively removes a “pause printing” stage,
streamlining shut down. To enable Auto Abort, select Options from the Menu bar and
click on Imager Configuration, then click on the System Settings tab. The Auto Abort
check box will be in the Other Settings box in the lower left of the System Settings tab.

Finally, there is a purge selection. An integer — 0 included — must be in this box. If
you enter a number, a purge graphic will print on the first selected number of pieces
under the imager. This graphic uses every print nozzle in every imager on the ma-
chine. When the machine is started and stopped for periods of time and the cartridges
remain uncapped, it is a good idea to purge the cartridges for a couple of pieces at the
start of the run. Examine the results of the purge to find clogged nozzles. Use this ex-
amination to accept print quality, stop and clean pens, or replace the pen. Also use
this graphic in conjunction with stitching to correctly line up the pens.

To start printing, click on the green Start Print Job button. VWhen printing, the button
turns red. To stop, click on the red Stop Print Job button.
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Advanced Pfinting Topics

The previous sections dealt with using the ACCUFAST software to print mail pieces featuring
variable data. Much printing relies more on fixed data and text than variable data. The follow-
ing sections will explore the printing of bar codes as a primary example of fixed data printing.

There are also several important advanced printing features that are explained. These fea-
tures allow the user to track job performance and cost, set up capping and cleaning parame-
ters, load different configurations, use job notes, and set pen parameters to take advantage of
different inks’ special properties.

Bar Code Printing

Typically, a fixed bar code will begin as a message line. The alphanumeric code is typed into
the design screen and then Bar Code is specified as a descriptor for printing. This allows the
BAR CODE PROPERTIES tab to appear.
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Click on the Barcode Properties tab to access all of the various bar code options including the
type of bar code, printing of text, calculation of check digit and the application of shaving.
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The drop down window for bar code type exposes all barcodes that are resident in the software. In
this example a Code 128 bar code is used.

Note: If the data does not match the bar code requirements, an error message will be
displayed on the design screen and nothing will print.

Choose text printing options with or without a separation of text and bar code.
Check the box that is appropriate to the data. In this case, only numbers are needed and allowed.

Always check the optimize box. This allows the software to make sure that correct bar code printing
ratios are maintained regardless of the size of the box on the design screen. If this box isn't
checked, the bar code will stretch of shrink to fit the box and although it might look good will be un-
readable.

Adjust shaving percent based on the printed result. This is a way of reducing the width of the indi-
vidual bars in the code to take natural wicking of the image into account. Shaving is an important
tool in the creation of high quality bar codes. It is best used when you can measure the results with
a verifier.

Many bar codes print best at reduced resolutions. Shaving might not be needed.



Specialty Inks

ACCUFAST Printers are often used to print on glossy materials such as aqueous coated mail
and packaging items, PVC credit cards, phone cards, tags and the like. These non-porous
materials require the use of special inks that use a solvent (typically an aicohol) as a carrier
fluid in the ink rather than water. These inks need a different set of firing parameters to be suc-
cessfully used.

The ACCUFAST print control software allows a user to assign different pen firing parameters
to each cartridge installed in the machine. Once set, these parameters are stored as a part of
a configuration file. Store the specialty inks files as separate configurations for use when a
particular job dictates.
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Click on the Options and Advanced Configuration Tabs

Click Pen Parameters

Select the pen (cartridge) number that you wish to edit.

By using the radio buttons, select the pen firing parameter that corresponds to
the type of ink being used.

5. Click OK to save the pen parameter settings.

F= 0 g

Note that you can set these parameters differently for each pen. This enables you to use sol-
vent and water based inks side by side. If you are doing this, make sure that the system is set
up correctly and that the pens are what and where they are expected to be in the imagers.

All advanced Configuration Settings are stored with a System Configuration.
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Automatic Capping

Some imagers (3 pen jet engine—not found on P3, P4 or P8 Models) are equipped with an
automatic capping feature. This is as it says a device that caps the pens after use. Several
options exist in setting up an AC (AutoCap) imager. These options are in the Advanced Con-

figuration Menu.
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Click Options and Advanced Configurations Tabs.

Select Purge Settings

A variety of options exist. For a full definition of each option, use the HELP files.
Select the option set that works best. Typically, a clean on park with a purge in
the cycle as well. Heavy purging wastes ink, keep it as little as works to clean
the pen and preserve print quality.

b
2.
3.
4.

Spit Volume comes into play when the Sparse Spit option has been selected (Options, Imager
Configurations, Imager Settings).

To use the A/C features the Service Station Enabled box needs to be checked (Options, Sys-
tem Settings under Other Settings).
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